
 

 

 

Opciones con multiples respuestas 

 

PREGUNTAS CON MULTIPLES RESPUESTAS 

 

1)Al guardar una fotografía con texto: 

si
 

Respuesta Correcta 

 Al guardar en EPS se pueden conservar los datos vectoriales del texto para otras aplicación 

si
 

Respuesta Correcta 

 Al guardar en PDF podernos incrustar la fuente 

si
 

Respuesta Correcta 

 Al guardar en TIFF hay que incluir capas para conservar los datos vectoriales 

no
 

Respuesta Correcta 

 Al guardar en JPEG se puede seleccionar la opción incluir texto 

 

2)Al crear un espacio de trabajo (workspace) ¿Qué se puede configurar? 
si

 

Respuesta Correcta 

 Se puede guardar la ubicación de las paletas 
si

 

Respuesta Correcta 

 Se puede guardar los atajos de teclado 
si

 

Respuesta Correcta 

 Se puede guardar la configuración de los menú 
si

 

Respuesta Correcta 

 Se pueden guardar bibliotecas de Muestras (Swatches) 



 

3)Al crear un nuevo documento (new document), en la ventana New se puede: 

si
 

Respuesta Correcta 

 Dar tamaño a la imagen 

si
 

Respuesta Correcta 

 Definir el modo de color 

no
 

Respuesta Correcta 

 Configurar las reglas 

si
 

Respuesta Correcta 

 Puedo ajustar la resolución y profundidad de Bit 

4. 

Total de preguntas: 3 puntos 

4)Para convertir un trazado (path) en selección: 

NO
 

Respuesta Correcta 

 Desde el menú Selección 

SI
 

Respuesta Correcta 

 Desde el menú contextual de la paleta Trazados (Paths) 

SI
 

Respuesta Correcta 

 Desde el botón cargar trazado como selección (Load path as a selection) 

 

5.¿Cuáles dos factores son los que mas influencian las decisiones de diseño cuando 
se trabaja en un proyecto para un cliente? (selecciona dos) 

SI
 

Respuesta Correcta 

 Metas del cliente 
NO

 

Respuesta Correcta 

Tendencias del diseño 



SI
 

Respuesta Correcta 

 Publico objetivo (target audience) 
NO

 

Respuesta Correcta 

Tendencias del diseño en la temporada 
NO

 

Respuesta Correcta 

 El estilo personal del diseñador 
 

Total de preguntas: 4 puntos 

6.¿Cuál es una característica clave para ajustar la toma fotográfica en ambientes 

con diferente iluminación? 

SI
 

Respuesta Correcta 

 captura  

SI
 

Respuesta Correcta 

 flash 

SI
 

Respuesta Correcta 

 resolución 

SI
 

Respuesta Correcta 

 megapíxeles 

 

Total de preguntas: 6 puntos 

7. Marque las paletas que existen en Photoshop: 

 

Respuesta Correcta 

 Párrafo (Paragraph) 

SI
 

Respuesta Correcta 

 Estilos (Styles) 

SI
 

Respuesta Correcta 

 Muestras (Swatches) 



SI
 

Respuesta Correcta 

 Estilos de carácter (Character Styles) 

SI
 

Respuesta Correcta 

 Trazos (Paths) 

NO
 

Respuesta Correcta 

 Apariencia (Aparence) 

 

8.¿Cuáles son las TRES mejores opciones relacionadas con las correcciones de 

color con Photoshop? 

si
 

no 

 trabajar en modo CMYK 

si
 

Respuesta Correcta 

 usar capas de ajuste 

no
 

si 

 trabajar con un monitor calibrado y perfilado 

no
 

Respuesta Correcta 

 disminuir la resolución de las imágenes a la resolución final antes de la corrección de color 

si
 

Respuesta Correcta 

 retocar una imagen (quitar ruido, taras,tasgaduras, etc) antes de realizar la correcciones de 

color 

 

1. ¿Cuál es una característica clave para ajustar la toma fotográfica en ambientes con 
diferente iluminación? 

SI
 

Respuesta Correcta 

 captura  
SI

 

Respuesta Correcta 

 flash 



SI
 

Respuesta Correcta 

 resolución 
SI

 

Respuesta Correcta 

Megapíxeles 

 

2. Marque las paletas que existen en Photoshop: 

SI
 

Respuesta Correcta 

 Párrafo (Paragraph) 

SI
 

Respuesta Correcta 

 Estilos (Styles) 

SI
 

Respuesta Correcta 

 Muestras (Swatches) 

SI
 

Respuesta Correcta 

 Estilos de carácter (Character Styles) 
 
 

SI
 

Respuesta Correcta 

 Trazos (Paths) 

NO
 

Respuesta Correcta 

 Apariencia (Aparence) 
 
¿Cuáles son las TRES mejores opciones relacionadas con las correcciones de color con 
Photoshop? 

si
 

no 

 trabajar en modo CMYK 
si

 

Respuesta Correcta 

 usar capas de ajuste 
no

 

si 

 trabajar con un monitor calibrado y perfilado 
no

 

Respuesta Correcta 



 disminuir la resolución de las imágenes a la resolución final antes de la corrección de color 
si

 

Respuesta Correcta 

 retocar una imagen (quitar ruido, taras,tasgaduras, etc) antes de realizar la 
correcciones de color 
 

12. Cuando se utiliza el Pincel corrector puntual para deshacerse de las arrugas, líneas, etc, 

cual es la mejor opción para usar? 

2
 

si 

 Content-aware Correct  
4

 

no 

 Créate texture  
1

 

si 

 Proximity match  
3

 

no 

 Normal 
 

13. ¿Se puede aplicar calado (feather) después de hacer una selección? 

si
 

no 

 No, sólo se aplica desde la barra de opciones  
si

 

Respuesta Correcta 

 Si, desde el Menú Select > Modify > Feather  
no

 

Respuesta Correcta 

 Sólo si se ha guardado la selección  
si

 

Respuesta Correcta 

 Si, desde el Menú Select > Refine Edge 
 

14. Cuáles tres elementos deben ser identificados para cada tarea en un plan de proyecto? 

(selecciona 3) 

si
 

no 



 Costo 

no
 

si 

 Responsable 

no
 

Respuesta Correcta 

 Software 

si
 

Respuesta Correcta 

 Fecha de término 

no
 

si 

 Horas estimadas 

15.  ¿Cuáles son las TRES mejores opciones relacionadas con las correcciones de color con 

Photoshop? 

si
 

no 

 trabajar en modo CMYK 
no

 

si 

 usar capas de ajuste 
si

 

Respuesta Correcta 

 trabajar con un monitor calibrado y perfilado 
si

 

no 

 disminuir la resolución de las imágenes a la resolución final antes de la corrección de color 
no

 

si 

 retocar una imagen (quitar ruido, taras,tasgaduras, etc) antes de realizar la 
correcciones de color 
 

16. ¿Cuáles dos factores son los que mas influencian las decisiones de diseño cuando se 

trabaja en un proyecto para un cliente? (selecciona dos) 

si
 

Respuesta Correcta 

 Metas del cliente 



no
 

Respuesta Correcta 

 Tendencias del diseño 
si

 

Respuesta Correcta 

 Publico objetivo (target audience) 
no

 

Respuesta Correcta 

 Tendencias del diseño en la temporada 
no

 

Respuesta Correcta 

 El estilo personal del diseñador 
 

17.  Cuáles de las siguientes fases de producción son responsabilidad específica del artista en 

un plan de trabajo de Photoshop? (selecciona 2) 

no
 

Respuesta Correcta 

 Estimación del presupuesto  
si

 

Respuesta Correcta 

 Procesamiento final de la imagen  
no

 

Respuesta Correcta 

 Evaluación de la audiencia y análisis  
si

 

Respuesta Correcta 

 Crear gráficos completos de la muestra 
 

18. ¿Cuáles TRES de las siguientes afirmaciones son verdaderas acerca del color? 

no
 

Respuesta Correcta 

 Los colores primarios son rojo, verde y azul 
si

 

Respuesta Correcta 

 Los colores complementarios son usados para crear contraste 
si

 

Respuesta Correcta 

 Los colores complementarios son creados al mezclar colores primarios 
si

 



Respuesta Correcta 

 Los colores análogos son colores que pueden ser encontrados justo al lado en la rosa 
cromática 

no
 

Respuesta Correcta 

 Los colores análogos son colores que pueden ser encontrados en el lado opuesto de 
la rosa cromática 
 

19. ¿Cuáles DOS de los siguientes términos están relacionados con el principio de diseño de 

"movimiento"? 

no
 

Respuesta Correcta 

 Foco 

si
 

Respuesta Correcta 

 Ritmo 

no
 

Respuesta Correcta 

 Armonía 

no
 

Respuesta Correcta 

 Simetría 

si
 

Respuesta Correcta 

 Repetición 

 
20. Con el filtro Punto de fuga (Vanishing Point): 

si
 

Respuesta Correcta 

 Se pueden construir más de una malla  
si

 

Respuesta Correcta 

 Una malla puede tener más de una cara  
no

 

Respuesta Correcta 

 Las mallas se generan automáticamente  
si

 

Respuesta Correcta 



 Las selecciones respetan la perspectiva de las mallas 
 
 

21.  Cuáles tres elementos deben ser identificados para cada tarea en un plan de proyecto? 

(selecciona 3) 

no
 

Respuesta Correcta 

 Costo 
si

 

Respuesta Correcta 

 Responsable 
no

 

Respuesta Correcta 

 Software 
si

 

Respuesta Correcta 

 Fecha de término 
si

 

Respuesta Correcta 

 Horas estimada. 
 

22. Qué elemento conserva el contenido original de la imagen con todas sus 
características, de tal modo que se posibilita la edición no destructiva de una capa?  

Objeto Inteligente. 
23. . ¿Cuál es la función principal de Adobe Bridge?  
Administrar, abrir y ver archivos  
 
24. . ¿Cómo se crea una página web que tenga múltiples imágenes JPEG en la barra de 
navegación?  
Bridge > Output >Web Photo Gallery (Bridge > Salida > Galería de fotografías Web)  
 
25. ¿Cuáles tres tipos de archivos pueden utilizarse para la web?  
GIF, JPG, PNG  
 
26. ¿Qué factores deben tener más influencia sobre las opciones de diseño al trabajar en un 
proyecto para un cliente?  
Objetivos del Cliente y Público Objetivo  
 
27. ¿Cuáles son fases de Producción que específicamente constituyen la responsabilidad de un 
artista en un plan de proyecto de Photoshop?  
Procesamiento final de las imágenes y Creación de una muestra exhaustiva de gráficos 
¿Quién identifica las características del público objetivo al desarrollar materiales de marketing 
para una compañía?  
El cliente  



 
28. ¿Qué es la Regla de Tercios?  
Nueve secciones iguales, que dividen la imagen mediante dos líneas horizontales igualmente 
espaciadas y dos líneas verticales igualmente espaciadas  
 
32. Es considerada la unida mínima de una imagen  
Pixel. 
33. Menciona tres principios que correspondan al diseño  
La repetición es la recurrencia de un elemento completo sin ningún cambio  
Armonía es cuando algunos o muchos componentes comparten una o dos características.  
La unidad se refiere a la sensación de que todo en el dibujo tiene su lugar y lo completa  
 
34.. ¿Cómo se crea un archivo RAW de cámara?  
Crear el archivo en cámara digital  
35. ¿Qué principio aplicaría para garantizar un diseño visualmente atractivo?  
Regla de tercios  
36. ¿Qué hará un explorador si no puede igualar exactamente los colores seleccionados para una 
imagen?  
Interpolar  
37. ¿Cuál archivo brinda los datos para una imagen sin procesar?  
RAW de cámara  
38. ¿Qué elemento conserva el contenido original de la imagen con todas sus características, de tal 
modo que posibilita la edición no destructiva de una capa?  
Objeto Inteligente 
39. ¿Qué oración es correcta en cuanto a lo que permite la ley de uso justificado (Fair Use Act)?  
Permitir utilizar material con derechos libremente para crítica, enseñanza, educación, noticias o 
investigación sin permiso del titular.  
 
40.. ¿Qué herramienta es la más recomendable para modificar una imagen y eliminar partes no 
deseadas usando patrones de la misma imagen?  
La Herramienta Tapón Clonar  
41. ¿Qué función se puede utilizar para almacenar información sobre copyright y propiedad?  
Metadatos . 
42. 53. ¿Qué factor es determinante en la planeación de un proyecto de Photoshop?  
Determinar las metas del proyecto y de la audiencia  
43. ¿Cuál es el Formato de archivo fuente de Photoshop?  
PSD  
44. ¿Qué profundidad de bits tiene una imagen indexada?  
8  
45.. Una Importante y conservadora compañía de seguridad necesita un logotipo y materiales de 
marketing que promueven la seguridad, la confianza y la solidez. ¡Cuál seria el tipo de fuente más 
apropiado?  
Fuentes Sans – Serif  
 
46.. ¿Qué comando permite realizar una impresión múltiple de una imagen en una sola Impresión?  
PhotoMerge  
 



47. ¿Qué modalidad de color es el más eficiente para la salida final cuando un poster se va a 
imprimir en una  
prensa Offset?  
CMYK  
48. ¿Qué ventajas tiene el uso de grupos de capas?  
Permite agrupar las capas y aplicar o modificar propiedades de manera simultánea 
 
49. ¿Qué hace pintar con blanco o negro dentro de la máscara cuando se utiliza una máscara de 
capa?  
El Negro Oculta la imagen, el Blanco la Revela  
 
50. . ¿Qué opción esta disponible para la interpretación en la gestión de color para imprimir?  
Relativo colorimétrico  
 
51. . ¿Cómo se puede visualizar un documento RGB para ver como quedará al imprimirlo en CMYK 
sin modificar los datos de la imagen?  
Ir a View > Proof setup > Working CMYK (Vista > Ajuste de prueba > Trabajar con CMYK)  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 


